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This material is for informational purposes only and is not intended as an offer or 
solicitation for the purchase or sale of any product, service or security. This document 
contains purely factual information and is an outline of matters for discussion only.

It does not constitute financial product advice and should not be relied on as such. It is 
indicative only and is not intended to set forth a final expression of the terms and 
conditions of any financial product. Nothing in this document shall be construed as a 
solicitation to buy or sell any security or product, or to engage in or refrain from 
engaging in any transaction. None of the information takes into account your personal 
objectives, financial situation or needs and you must determine whether the information 
is appropriate in terms of your particular circumstances.

Information provided herein is believed to be reliable but Blackwell Global does not 
warrant its accuracy or completeness. Blackwell Global is not obligated to update the 
material in light of future events. This communication does not constitute a 
recommendation to take any action, and Blackwell Global is not providing investment, 
tax or legal advice. Blackwell Global and its affiliates accept no liability whatsoever for 
any use of this communication or any action taken based on or arising from the material 
contained herein. Not all products and services are available in all geographic areas. 
Your eligibility for particular products and services is subject to final determination by 
Blackwell Global and/or its affiliates. 

This user guide is issued and approved by Blackwell Global, any investment services or 
products offered therein are made available solely to market counterparties and 
intermediate customers. No other person may rely on the contents of this user guide nor 
have access to any such investment services or products. This user guide is for 
informational purposes only. 

Additional information is available upon request.

Disclaimer1
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Installation2

STEP 1

Run the bgt4setup.exe file. 

STEP 2

Read through the information and click the “Next” button to continue.
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Read through the End-User Licence Agreement and click the "Yes, I agree with all 
terms of this license agreement" box to agree with the terms, then click the 
“Next” button to continue.
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STEP 3
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Select the installation folder, then click “Next”.

STEP 4
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STEP 5

Once the installation process has been completed click the "Finish" button. 
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Once Blackwell Trader has launched, you will be prompted to fill in the application form 
to open a demo account.

You are also able to open a new demo account by opening the "File" menu and clicking 
on "Open An Account".

Proceed to fill in the account details as shown in the image below: 
After choosing your preferred leverage and deposit value, click the "I agree to subscribe 
into your newsletters" check box and press the "Next" button. 

STEP 6
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Once the server appears in the window, click the "Next" button.

STEP 7
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Write down your Login ID, Password and Investor (read only password).

Once you click on the "Finish" button, Blackwell Trader will automatically log into your 
new demo account and you can proceed to trade.  

STEP 8
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Changing your Password
To change your password, open the "Tools" menu  and select "Options" from the 
drop down list.
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Click on the "Change" button. 

Enter your "Current Password" and your "New password", then click "OK".
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Blackwell Trader MetaTrader 4 User Interface3

Three of the main windows (except for the Chart Window 2.4) are activated by opening 
the "View" menu and clicking on the item you wish to view, for example
"Market Watch".

There are four main windows in Blackwell Trader:

3.1 Market Watch

3.2 Navigator

3.3 Terminal

3.4 Chart

2.1

2.2

2.3

2.4
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3.1 Market Watch (Real-time Quotes)
The Market "Watch" window shows the real-time quotes of the symbols. Each symbol's 
Bid and Ask prices are displayed. If you double-click on a symbol, or press "Ctrl+M" on 
the keyboard, the order window will appear.

Right-clicking on the "Market Watch" window will produce the context menu as shown:
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New Order: Enables the window to Open/Close a position or to place a new Pending     
Order (You can also double clickon the symbol).

Chart Window: Enables the chart of a symbol.

Tick Chart: Shows the Tick Chart  for the selected instrument.

Hide: Hides the specified symbol from the list in the "Market Watch" window.

Hide All: Hides all inactive symbols from the list in the "Market Watch" window. 
Specific symbols will not be deleted if you have open positions or open charts using 
those symbols.

Show All: Displays all available symbols in the "Market Watch" window.

Symbols: Enables the window where you can hide/show the selected instruments.

Sets: Saves/Adjusts/Deletes the custom settings on the "Market Watch" window.

High/Low: Shows/Hides columns with the highest and the lowest  prices for 
each instrument.

Time: Displays a column with the arrival time of the latest quote for each instrument.

Grid: Hides/Unhides gridlines in the "Market Watch" window.

Popup Prices: Opens the real time quotes window for selected instruments.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

3.2  Navigator
The Navigator window allows you to select your account, technical indicators, custom 
indicators, Expert Advisors and the scripts.This window can be activated by 
pressing "Ctrl+N".

3.2.1  Expert Advisors
An Expert Advisor (EA, also known as Forex trading robot, automated Forex trading 
software) is a program written in the MetaQuotes Language 4 (MQL4), designed to 
automate trading activities on MetaTrader 4. These EAs allow you to trade automatically, 
monitoring the market for you and if you want, they can execute trades without your 
direct intervention. On MetaTrader 4, you can backtest, optimise and trade your Expert 
Advisor strategies.
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Once your EA is seen in the navigator window, activate Expert Advisors by 
clicking on the "Expert Advisors" button located at the top of Blackwell Trader 
in the toolbar.

Installation of an Expert Advisor  

1. Close off Blackwell Trader.

2. Locate the windows folder where Blackwell Trader was installed.

3. Copy the desired EA file into "Experts" folder.

4. Open Blackwell Trader.

5. The newly installed EA will be located in drop down menu of navigator window
as shown below.
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3.2.2  Scripts
Scripts are also programs written in MQL4. It is very much like EAs in that it has the 
ability to open, close and modify trades. However, there are two differences between 
Scripts and EAs.

The main difference is the way they are used : Expert Advisors are executed each time 
a new quotation arrives, while Scripts are executed only once when attached to a chart. 
For example, with a script, you can implement various sequences of actions for the client 
terminal, displaying additional messages or setting a stop loss for particular positions.

The other difference is that you must enable EAs prior to using them, while Scripts do not 
require enabling.

3.3  Terminal
The terminal gives you a snap shot of what is going on in the market and what is going 
on in your account. The window can also be activated by pressing "Ctrl+T".

1. Trade: The “Trade” tab displays the current open positions of the account, the 
    account balance line and the financial results of open positions, as well as pending 
    orders placed.

2. Account History: The "Account History" tab displays closed positions,
    cancelled pending orders of the account, and any other historical event that occurred
    to the account.

3. Alerts: The "Alerts" tab contains information about created alerts. The alerts are 
    intended for signalling about events in the market.

4. Mailbox: The "Mailbox" is intended for working with the internal mailing system.

5. Experts: The "Experts" tab displays the  record of each of the move that the Experts 
    Advisor has made.

6. Journal: All operations and events performed are written to special statistics journals 
    that are represented as text files.
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3.4  Chart Window
Creating a New Chart

Click on the icon              in the window toolbar (refer to section 3.1). You can create an 
unlimited number of chart windows and arrange the charts in anypreferred layout as 
shown below:
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Changing Chart Design 

You can customise the design of the charts based on your personal preference. 
Right-click anywhere in the chart window and select "Properties".
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The colour tab of Chart Properties window. 
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Changes in settings in the common tab.
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Various Toolbars of Blackwell Trader4

There are four main toolbar groups:
1. Window Toolbar 
2. Charts Toolbar 
3. Periodicity Toolbar
4. Object Toolbar 

4.1  Window Toolbar

The functionality of each icon in the toolbar in the order from left to right:

1. New Charts: This is to add a chart for any selected symbol from the list. 

2. Profiles: Profile shows a collection of charts on the platform. The default profile will 
    appear on the screen for the first opening of Blackwell Trader. Any changes on the  
    profile will be saved to the Default profile unless you are saving as a new profile. 
    To create a new profile with changes, click on the "Save Profile As" and create a new 
    profile name. You may create and remove profiles however the Default profile cannot 
    be deleted.

3. Market Watch: Refer to section 2.1. 

4. Data Window: Select this to make the Data Window appear. Move your cursor to any 
    candle in a chart and available data of the candle will be shown in the Data Window.

5. Navigator: Refer to section 2.2. 

6. Terminal: Refer to section 2.3. 

7. Strategy Tester: This window appears on the bottom of the platform. This is for Expert 
    Advisors testing.

8. New Order: The Order window will appear on the platform. The symbol selected  is 
    taken from the current active chart on the platform. 

9. Meta Editor: This opens a new window to edit Expert Advisors, Custom Indicators 
    and Scripts.
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4.2  Charts Toolbar

The functionality of each icon in the toolbar in the order from left to right:

1. Bar Chart: If selected, it will display the chart using bars. Can also be accessed
by pressing "Alt+1".

2. Candlestick Chart: If selected, it will display the chart using candlesticks. Can also be
accessed using by pushing "Alt+2".

3. Line Chart: If selected, it will display the chart as a line graph. Can also be accessed
using by pushing  "Alt+3".

4. Zoom In: Click to zoom in.

5. Zoom Out: Click to zoom out.

6. Auto Scroll: If selected, the latest bar will always show on the screen. To see previous
bars, deselect the Auto Scroll.

7. Chart Shift: Select this to shift the chart to the left, allowing more space on the right
side of the chart for future prediction of trends.

8. Indicators: You can click this to select any indicators instead of using the
Navigator window.

9. Periodicity: You can choose the time periods for each bar/line to represent, from 1, 5,
15, 30 minutes (M1, M5, M15, M30 respectively), 1 hour (H1), 4 hours (H4), 1 day (D1),
1 week (W1) and 1 month (MN).

10. Templates : Click to load, save or delete templates as desired.
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4.3  Periodicity Toolbar

This is the "Periodicity" toolbar. You can choose the time periods for each bar/line to 
represent, from 1, 5, 15, 30 minutes (M1, M5, M15, M30 respectively), 1 hour (H1), 
4 hours (H4), 1 day (D1), 1 week (W1) and 1 month (MN). You can also do this by right 
clicking anywhere on the chart and access to the chart settings.

4.4  Object Toolbar

The functionality of each icon in the toolbar in the order from left to right:

Cursor: This is the standard arrow cursor by default for selecting items.

Crosshair: This shows the number of bars, pips and prices at the second point. Press of 
the two points in a chart. Select Crosshair. Move to active chart window and select the 
first point. Space and hold down left mouse button and move to the second point. line 
connecting the two points will be drawn and the date shows number of bars/number of 
pips/price at the second point. Release the left mouse button and all will disappear.

Vertical Line: Select the icon, place at desired position. To make changes, double 
clickon selected line and handles (two small white squares) drag to new position or right 
click near the line to access line properties to make changes. Double click after making 
changes to remove handles and to place line at a particular time.

Horizontal Line: This works the same as drawing Vertical line. This function is to draw 
support and resistance levels.

Trend Line: This function is to draw a Slanting or Trend line. Select the Trend Line. 
Place at the first point, hole down left mouse button and select the second point on the 
line. Trend line will snap to nearest point. Double click to show the handles to check if a 
proper point is selected. There are three handles in the Trend line. The middle handle is to 
move the whole line. The two end handles is movable, so that they snap and attached 
automatically at the end of a handle. 

1.

2.

3.

4.

5.
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6. Equidistant Channel: This function is to draw an Equidistant Channel , which
represents two parallel lines that connect maximum and minimum prices.

7. Fibonacci Retracement: This function is to draw the Fibonacci Retracement object.
Fibonacci Retracement’s are put together as follows: first, a trendline is built between
two extreme points, for example, from the low to the opposing high. Then, nine
horizontal lines intersecting the trend line at Fibonacci levels of 0.0, 23.6, 38.2, 50,
61.8, 100, 161.8, 261.8, and 423.6 percent are automatically shown.

8. Text: The text function is to allow text to be written on the chart window. Click on the
"Text" button and draw where you wish to place the text. Enter the text you wish to be
displayed on the chart into the “Text” field and click "OK".

9. Text Label: The text label function is to allow text to be written in the form of a label
on the chart window. It works in the same way as the Text function.

10. Arrows: This function allows the placement of arrows and other icons on the chart
window. Click on the Arrows button and select which icon you wish to add to the
chart, then click and drag on an area on the chart you wish to place the icon.
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Trading5

5.1  Opening a Position
In Blackwell Trader there are six ways to open a trade:

1. Double click the symbol that you choose to place an order in
the "Market Watch".

2. Right click the symbol in the "Market Watch", then select the "New Order".

3. Right click on the tab of the "Terminal" and select "New Order".

4. Right click on the chart window and select the "Trading", then the "New Order".

5. Press the "F9" button.

6. Click the "Tools", and select the "New Order" from the context menu.

Select the desired Symbol and Volume, then click "Sell" or "Buy" to place the order. 
Click "OK" to complete the order when the confirmation of the order appears.
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The position is now listed in the "Trade" tab of the "Terminal" window.

27  of  34



M e t a T r a d e r  4  U s e r  G u i d e  

Alternatively, you can double-click on the open position in the "Trade" tab of the 
"Terminal" window, opening the order window. 

From the order window, click on the "Close (order details) by Market" to close 
the order.

5.2  Closing a Position
Right click the position in the "Trade" tab of the Terminal window to obtain the context 
menu and select "Close Order".

28  of  34
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5.3  Placing a Pending Order
A pending order allows the user to buy or sell a symbol at a pre-defined price in the  
future. This type of order is used for opening a trade position when future quotes reach 
the pre-defined level.
 
There are four types of pending orders available:

1. Buy Limit: Place a Buy order, provided the future "Ask" price is equal to the 
    pre-defined value. The current price level is higher than the value of the placed order. 
    This type of order is usually placed in anticipation that the symbol price, having fallen 
    to a certain level, will increase.

2. Buy Stop: Place a Buy order, provided the future "Ask" price is equal to the 
    pre-defined value. The current price levelis lower than the value of the placed order. 
    This type of order is usually placed in anticipation that the symbol price, having 
    reached a certain level, will continue to rise.

3. Sell Limit: Place a Sell order, provided the future "Bid" price is equal to the 
    pre-defined value. The current price level is lower than the value of the placed order. 
    This type of order is usually placed in anticipation thatthe symbol price, having 
    increased to a certain level, will fall.
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4. Sell Stop: Place a Sell order, provided the future "Bid" price is equal to the 
    pre-defined value. The current price level is higher than the value of the placed 
    order. This type of order is usually placed in anticipation that the symbol price, 
    having reached a certain level, will continue to fall.
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If you would like to place a pending order, switch to "Pending Order" from 
under "Type" in the "New Order" window.

After selecting "Pending Order", you can set the following parameters:

1. Symbol: The type of product you wish to trade.

2. Volume: The quantity you wish to trade.

3. Stop Loss: A price to close an open position at a less profitable price to the customer
than the price at the time of placing the order. If a price is not specified, zero will be
entered in this field. The Stop Loss price will be filled in red if an order was closed by
the Stop Loss, or the distance between the current price and the Stop Loss price of an
open order is less than 10 pips.
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4. Take Profit: A price to close an open position at a more profitable price to the
customer than the price at the time of placing the order. If a price is not specified, zero
will be entered in this field. The Take Profit price will be in green if an order was closed
by the Take Profit, or the distance between the current price and the Take Profit price
of an open order is less than 10 pips.

5. Price: Price level at which the order will be triggered.

6. Expiry: The execution will be pending if Expiry box is not selected. If the box is
selected, the date can be set on the preferred pending order. The selected pending
order will be deleted after the specified date.

Click the "Place" button  to complete your order. You can also see your order in "Trade" 
in the "Terminal".
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5.4  Modifying or Deleting an Order
To modify an order, you can right click on the open position in the "Trade" tab of the 
"Terminal" window then select "Modify or Delete Order".  

For currently open orders, the Stop Loss and Take Profit can be modified.

For Pending Orders, the Price,Stop Loss, Take Profit, and Expiry can be changed. 

You can enter new data into the fields then click the "Modify" button to save the new 
parameters.
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If you need to delete a pending order you can click the "Delete" button.
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